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EARTHQUAKE

ANALYSIS WITH SAP2000

EARTHQUAKE ANALYSIS EXAMPLE

The earthquake analysis capabilities of SAP2000 are demonstrated
using a railroad bridge bent designed in accordance with the AREMA
Manual for Railway Engineering.
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EARTHQUAKE ANALYSIS WITH SAP2000

Prepare finite element model

= Column properties: #1o Tor 38 ¢ RoReS W g o

5’ diameter
Assume e = 0.35 |
Use I = 10 I, for stiffness in joint areas

= Bent cap properties:

13-2 BAR BUNDLES)
Assume | = 0.75 Ig_ o , |
Use | = 10 I for stiffness in joint areas *|

6.5 wide x 6’ deep I "u u L,_,.,, o
C
e

Lo 'f: .
= Dead loads: : _ﬁ—:a :

L—- 11 TOT 14

7-2 BAR BUNDLES)

Superstructure load = 2418 kips/61.2 ft = 39.5 kips/ft
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EARTHQUAKE ANALYSIS WITH SAP2000

Response spectrum analysis

Response spectrum analysis is performed to verify that the column
design is adequate.

AREMA Response Spectra

Period (sec) Response (G's)
0.001 0.700 0,500 |
0.030 0.700 ‘
0.087 0.700 l
0.100 0.700 0.700 1 |
0.200 0.700 1
0.300 0.700 ;
0.400 0.700 06007 ! i
0.500 0.640 | |
0.600 0.567 0.500 | | |
0.700 0.511 7 ‘ ‘
0.800 0.468 e | |
0.900 0.433 £ 0.400 1 : 1
1.000 0.403 2 1 1
1.200 0.357 . ; ;
1.400 0.322 ' ; ; ; ; ; ;
1.600 0.295 ! ! ! ! !
1.800 0.272 0.200 | | | | | | |
2.000 0.254 l l l l l ‘
2.200 0.238 l l l l l l
2.400 0.225 0000 1= -—=-~--~ VT O (T T T T
2.600 0.213 | | | | | |
2.800 0.203 1 : : ; : ;
3.000 0.194 0.000 0.500 1.000 1.500 2.000 2.500 3.000 3.500

Period (seconds)
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EARTHQUAKE ANALYSIS WITH SAP2000

= |nput steps
1. Define mass

a. Select menu item: Define > Mass Source
b. Select mass definition option: From Loads
c. Add load case: Dead (with multiplier of 1)

Note: The dead load is automatically divided by gravity.
2. Define Response Spectrum Function

Select menu item: Define > Functions > Response Spectrum
Choose function type: Spectrum from File

Click: Add New Function

Type function name: AREMA

Select option: Period vs. value

Browse to and select “spectra.txt” file

Click: Display graph

Q=00 T
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EARTHQUAKE ANALYSIS WITH SAP2000

3. Define Modal Analysis Case

a. Select menu item: Define > Analysis Cases
b. Select case: MODAL

c. Click: Modify/Show Case

d. Enter maximum number of modes = 2

4. Define Response Spectra Analysis Case

Select menu item: Define > Analysis Cases

Click: Add New Case

Type case name = AREMA

Select analysis case type: Response Spectrum
Select loads applied from AREMA function

Enter Scale Factor = 32.2 (response values in G’s)
Click: Add

Q@000 T
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EARTHQUAKE ANALYSIS WITH SAP2000

5. Define Load Combination
a. Select menu item: Define > Combinations
b. Click: Add New Combo
c. Select DEAD and AREMA cases
d. Click: Add

Note: Response spectrum will automatically give +/- values
6. Perform Response Spectrum Analysis

a. Select menu item: Analyze > Run Analysis
b. Click: Run Now
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EARTHQUAKE ANALYSIS WITH SAP2000

= Verify results
1. Display results graphically

a. Select menu item: Display > Deformed Shape

I8 Deformed Shape (MODAL) - Made 1 - Period 0.23030 o (=] 3
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EARTHQUAKE ANALYSIS WITH SAP2000

b. Select menu item: Display > Show Forces/Stresses

¥ shear Force 2-2 Diagram (AREMA) - IEI Iil
. _ETe 2 = g5 4 =
o = |8 | g & R & q |3 2| =2 B
45,43 t17.4 57,1 446,71
471.4 2. 208 471, A
478 F ¥ L7, A 478.9F
436, 5 53 232 4E1.1F
7
488, 5F | Lz, 14 48 1.2k
¥
[ [N 11 [
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EARTHQUAKE ANALYSIS WITH SAP2000

2. Display results in tabular form

a. Select menu item: Display > Show Tables
b. Select output to verify
c. Select analysis cases to verify

File ‘Wiew Options Faormak
nits; &g MNoted I-Jl:uint Feactions j
Joint OutputCasze | Caselype StepType ul uz u3 A1 R2Z R3
Text Text Text Text Kip Kip Kip Kip-Ft Kip-ft Kip-ft
b 101 DEAD LinStatic 10,316 0 B34.134 1] -81.1603 0
101 AREMA, LinRespSpec b am 480983 0 h20814 1] B099.7 767 ]
201 DEAD LinStatic 2817 0 Ba4 529 1] 27 97R2 ]
201 ARERA LinRezpSpec b 2 h32.483 0 104167 1] AR26. 7034 ]
201 DEAD LinStatic 2111 0 705,054 1] 21.9003 1]
ant ARERA, LinRespSpec b & 532176 0 93318 1] A523.5348 ]
401 DEAD LinStatic 5.388 0 741 227 1] 49 0556 ]
401 ARERA, LinRezp5Spec b 2 4a81.254 0 03 889 1] 5100.1768 ]
Record: | |4 4 1 | M| of8
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EARTHQUAKE ANALYSIS WITH SAP2000

3. Verification computations

a. Verify: dead load reaction = total weight

2
Weight = o.15(@x14.7x4+ 6.5% 6 64j+ 2418 = 2965.6 kips

Dead load reaction =834.1+ 684.5+ 705.1+ 741.2 = 2964.9 kips

b. Verify: total mass = total dead load / gravity

Mass = 92.1 (Export joint masses to Excel and sum)
Weight / Gravity = 2964.9/32.2 =92.1

c. Verify: modal participating mass ratio > 90%

Ratio = 97% for mode 1
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EARTHQUAKE ANALYSIS WITH SAP2000

d. Verify: response spectra base shear = response x weight

Base shear = 481 + 532 + 532 + 481 = 2026 kips
Response for period =0.247 sec = 0.7 G
0.7 x (2965 — 173/ 2) = 2015 kips (within 1%)

e. Verify: structure period T -2~ ;J’V—K
K =40 kips / 0.0006 ft = 66667 k/ft (from unit load case)
T =2 x3.1416 x [2965 / (32.2 x 66667)]"* = 0.23 sec

(within 6% of SAP2000 analysis)
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EARTHQUAKE ANALYSIS WITH SAP2000

a.
b.
C
d

a.

= Check column design

1. Verify that column reinforcement is defined

Select menu item: Define > Frame Sections
Select property: COL

Click: Modify/Show Property

Click: Concrete Reinforcement

2. Analyze column

Select menu item: Options > Preferences > Concrete Frame
Design

Select design code: AASHTO

Select menu item: Design > Concrete Frame Design >
Select Design Combos

Remove all generated combos and add COMB1

Select column members to design
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EARTHQUAKE ANALYSIS WITH SAP2000

File

Frame
Station
Section
Combo

L=4.988
B=5.808

AASHTO Concrete 97 COLUMH SECTION DESIGH Type:

f.  Select menu item: Design > Concrete Frame Design > Start

Design/Check of Structure
Display Design Info

Right click on member with max ratio
Click: Details

TS @

. Concrete Design Information AASHTO Concrete 97

Units: Kip, ft, F

ID 282
Loc @.08080
ID COL
ID COHMBA

D=5.8688 dc=08.318

Select: Column P-M-M Interaction Ratio

Select menu item: Design > Concrete Frame Design >

E=518480.08080 fy=8648.000 fc=576.800 fcs=0.8080 fys=5760.008

AXIAL FORCE & BIAKIAL MOMENT CHECK FOR PU, M2, M3

Capacity Design Design Design Minimum
Ratio Pu M2 M3 M2
a.946 C80.368 8.008 3949 . 885 a.0848a

rits [

[ Iy ]
: S
i.-.i
Minimum
M3
g.888

© 2004 Robert Matthews

Page 14




EARTHQUAKE ANALYSIS WITH SAP2000

EARTHQUAKE ANALYSIS EXAMPLE - PART 2

Nonlinear static analysis

Nonlinear static analysis is performed to verify that the bent cap and
footing design is adequate.

» Develop plastic hinge properties

1. The plastic hinge properties are based on 1.3 times the nominal
moments from an axial-moment interaction diagram (Refer to
AREMA Chapter 9 section 1.4.7.3.1 Weak Column Provisions).
Similar requirements are contained in AASHTO 16th edition,
Division IA Section 7.2.2 Forces Resulting From Plastic Hinging
In The Columns, Piers, Or Bents.

2. Define a 3D P-M-M interaction surface with at least 3 curves (0°,
45°, 90°) using available software. Hint: For a circular member,
the 45 degree curve can be obtained by dividing the O degree
moment values by the square root of 2.
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EARTHQUAKE ANALYSIS WITH SAP2000

Interaction Diagram
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EARTHQUAKE ANALYSIS WITH SAP2000

Interaction Values

Curve 1 0.deg Curve 2 45. deg Curve 3 90. deg
P M3 M2 P M3 M2 P M3 M2
-12501 0 0 -12501 0 0 -12501 0 0
-10689 2110 0 -10662 1536 1536 -10689 0 2110
-9175 3872 0 -9148 2770 2770 -9175 0 3872
-7818 5452 0 -7791 3876 3876 -7818 0 5452
-6240 6610 0 -6236 4683 4683 -6240 0 6610
-4461 7272 0 -4480 5151 5151 -4461 0 7272
-2943 7010 0 -2975 4978 4978 -2943 0 7010
-1508 5967 0 -1551 4258 4258 -1508 0 5967
-129 4258 0 -198 3092 3092 -129 0 4258
1225 1915 0 1165 1442 1442 1225 0 1915
2134 0 0 2134 0 0 2134 0 0
Notes:

1. P values are modified to remove kink in interaction curve at
maximum allowed compression per AREMA code.
2. Compression is negative for SAP2000.
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EARTHQUAKE ANALYSIS WITH SAP2000

= |[nput steps
1. Define hinge properties

Select menu item: Define > Hinge Properties

Select defined hinge properties: Default-PMM

Click: Define New Property

Type property name: colhng

Uncheck default

Click: Modify/Show for PMM

Select scale factor for rotation: User SF (leave value = 1)
Click: Modify/Show Moment Rotation Curve Data

S@ 0 o0 T
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EARTHQUAKE ANALYSIS WITH SAP2000

I.  Enter values shown below and click OK

Point M/My Rot/SF
A 0 0
B 1 0
C 1 0.02
D 0.2 0.02
E 0.2 0.06

Note: Ultimate rotation from moment-curvature program is
not critical for this example, except must be high enough to
allow all hinges to form prior to failure.

Click: Modify/Show PMM Interaction Surface Data
Click: Define/Show User Interaction Surface

Change number of curves to 3

Enter scale factors = 1.3 for M2 and M3

Enter first and last P points for all curves

Type or copy and paste remaining undefined values and
click OK

o5 3T AT
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EARTHQUAKE ANALYSIS WITH SAP2000

2. Assign hinges to members

Select all members at column bottom

Select menu item: Assign > Frame/Cable/Tendon > Hinges
Add colhng with relative distance = 0

Select all members at column top

Select menu item: Assign > Frame/Cable/Tendon > Hinges
Add colhng with relative distance = 1

~P o0 TW

3. Define unit load case for nonlinear static analysis

Select menu item: Define > Load Cases

Type in FX, select OTHER and click Add New Load
Select nodes at top of columns

Select menu item: Assign > Joint Loads > Forces
Select FX and type in unit load of 10 kips in global X dir

©TLoOT
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EARTHQUAKE ANALYSIS WITH SAP2000

4. Define analysis cases

Select menu item: Define > Analysis Cases
Select DEAD and Click Modify/Show Case
Change analysis type to nonlinear and click OK
Click: Add New Case

Type case name: PUSH

Change analysis type to nonlinear

Select initial condition: Continue from State at end of
Nonlinear Case (DEAD)

Add FX for loads applied

Click Modify/Show load application

Select: Displacement Control

Enter displacement magnitude = 0.4

Click Modify/Show results saved

Select: multiple states

TRTTS @TrooooT

3
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EARTHQUAKE ANALYSIS WITH SAP2000

5. Perform nonlinear static analysis

a. Select menu item: Analyze > Run Analysis
b. Click: Run Now

= Verify results

1. Display results

a. Select menu item: Display > Show Static Pushover Curve

wlA Displacement
40073
360
3207
280 3

240 Iff
200 ]II .
1.60 J‘ I/I
1.20 {f
020 III
0.40

Base Reaction

PUUL PR o e i e
0. 50. 100, 180, 200. 250, 300. 3500 400, 450 «10°
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EARTHQUAKE ANALYSIS WITH SAP2000

b. Select menu item: Display > Deformed Shape

IH Deformed Shape (PUSH]} - Step 6 - |EI|£|

Ls JCPI [

© 2004 Robert Matthews Page 9



EARTHQUAKE ANALYSIS WITH SAP2000

c. Select menu item: File > Print Tables

Table: Element Forces - Frames

Frame Station OutputCase StepNum P V2 M3
Text ft Text Unitless Kip Kip Kip-ft
102 0.0000 PUSH 6.000000 -58.028 737.795 5493.2704
202 0.0000 PUSH 6.000000 -802.655 919.764 6825.4076
302 0.0000 PUSH 6.000000 -323.195 853.890 6328.7005
402 0.0000 PUSH 6.000000 -1781.067 1093.187 8028.0166

2. Verification computations

a. Verify: P-M3 values match 1.3 x interation diagram values

P 1.3x M M3 Difference

-2943 9114
-1781 8277 8028 3%
-1508 7758
-803 6890 6825 1%
-323 6034 6329 5%
-129 5535

-58 5513 5493 0%
1225 2489

= Check bent cap and footing design (not shown)
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